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FeatureCAM overview 

FeatureCAM is a CAD/CAM software suite that automates machining 
and minimizes programming times for parts on mills, lathes, and 
wire EDM. Unlike operations-based CAM systems, FeatureCAM 
generates toolpaths based on the features of the part, and 
automatically selects appropriate tools, determines roughing and 
finishing passes, and calculates feeds and speeds. The selections 
made can be based on the built-in machining knowledge that 
Delcam supplies 'out-of-the-box' with FeatureCAM, or from 
experience captured from your company, project or individual users' 
preferences. 

FeatureCAM includes five stand-alone modules: 
 2.5D Milling - 2.5D design and toolpath generation for 2- and 3-

axis mills.

 3D Milling - 3D surface modeling and 3-axis toolpath generation.

 3D Lite - a limited version of 3D milling.

3D Lite lets you mill only one surface per feature, but you 
can create multiple features. The strategies available in 3D 
Lite are Z-level rough, Parallel rough, Parallel finish, Isoline, 
and 2D spiral. 

 Turning - 2-axis design and toolpath generation for 2-axis lathes.

 Turn/Mill - Supports lathes with C and Y-axis milling capabilities.

 Wire EDM - 2- and 4-axis wire EDM toolpath creation.

The following add-on modules are also available: 

 RECOGNITION - 3D surface and solid import and the recognition
of 2.5D features from solid models. Accelerates making 2.5D and
turned parts from solid models.

 Tombstone - Multiple part manufacturing for horizontal or vertical
milling machines with indexers.
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 Solid Modeling - Solid modeling and tools for creating molds from
solid models.

 5-Axis Positioning - Manufacture 2.5D features from 5-axis
orientations.

 Native Import Modules - Native data can be read directly from
SolidWorks, SolidWorks Assemblies, Autodesk Inventor,
SolidEdge, Catia, NX, Pro-Engineer, and Step files.

 Machine Simulation - Modeling and simulation of a CNC machine.

 Advanced Turn/Mill (MTT) - Includes support for Turn/Mill in
addition to support for B-axis (5-axis positioning) and multiple
turret synchronization.

 Network Database and Licensing - Flexible product licensing allows
sharing FeatureCAM licenses across a network.

 5-Axis Simultaneous - Manufacture 3D features while changing
the tool axis.

Why creating toolpaths is so fast 
FeatureCAM has the unique ability to generate toolpaths and create 
NC code to run the machines with a minimum amount of user input. 

Traditional CAM systems are operations-based and require you to 
program every operation, one at a time, to create your part. 
FeatureCAM is feature-based; this means the part is created using 
features that describe that part, from simple holes, to complex 
pockets, to turned grooves. Machinable features contain information 
and rules describing how and where material removal should occur, 
cutting depths, whether to use climb cutting, whether to spot drill or 
center drill, and preferred machining strategies for roughing and 
finishing. This means that after you import or draw the part and 
identify its features, FeatureCAM automatically: 

 Selects the most appropriate tools and operations;

 Recommends machining strategies;

 Calculates speeds and feeds;

 Generates toolpaths and creates the NC code.

  You can customize this built-in 'intelligence' to your own style 
of cutting. 
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Introduction 
 
 
 
FeatureWIRE is structured similarly to all other FeatureCAM products and the 
steps are used to walk you through the process.  
 

4-Axis Wire EDM feature recognition from Solid 
 

• Open New Part Document. Select Milling setup.    
• Select the units you will use to model your part from among: Inch / Millimetre. 
• Select Millimetre. 
• Select how you would like to setup your stock. Select from:   
    Wizard / Properties / None.  
 
• Select None and Click OK.     
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Importing files from CAD systems 

• Open a new part file. You must have a part open to import geometry. 

• Select Import from the File menu. Select “4-axiswire.x_t” file as shown below. 
Click Open. 
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Import Results 

The import of the CAD data file is just the beginning of the import process in 
FeatureCAM.  After the file is imported, the Import wizard can be run to align the 
part to stock, size the stock and for some file formats, even perform some initial 

feature recognition.   

 

• Select “Use the wizard to 
establish the initial setup 
location and stock size” as 
shown below and  Click 
Next.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

             Pick Initial Setup Z Direction 

 
In this dialog box, you set the  
Z direction for the setup.  This 
will correspond to the Z axis of 
your machining coordinates.  If 
you are happy with the current 
Z direction, just Click Next. 
 
Options to change the 
direction of the Z axis: 
 
Keep as it is and Click the Next 
button. 
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Pick Initial Setup X 
Orientation 
In this dialog box you define 
the orientation of the setup 
X axis.   
Options to orient X direction, 
Keep as it is and Click Next. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   
Stock Type 
In this dialog box, you set the 
shape of your stock.   
To complete this dialog box: 
Select Block for rectangular 
stock. 
Select Round for cylindrical 
stock.  Select the axis that runs 
down the center of the stock. 
Select N-sided for the stock, 
and specify the number of sides 
for the stock. Symmetric shapes 
like hexagonal or triangular 
stock. 
 
Select Block and Click Next 
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Stock dimensions 
On this page you specify the size of your stock. The page is basically a three-column 
table showing you the size of the data and the size of the stock.   

•  Block Stock. 

•   Select Compute stock size from the size of the part, the stock is sized to fit the 
part.   In the second    column,   you can enter additional amounts to add to any 
stock dimension. Enter the dimensions as shown below. 

•  Click Next. 

 

 

 

Pick initial setup XYZ location 
This dialog box helps you set the part program zero. This will be the origin of the 
coordinate system for the NC program for this setup.   

 
• If you want to locate the origin at one of the points indicated by a pointing finger 

  button, click the button. 
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• Pick Location:  If you want to type the coordinates, enter the X, Y and Z 
coordinates. 

• Center of revolved surface:  Select the revolved surface as shown below. Click 
Next.    
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Is part indexed? 
In this dialog box you specify if you will be creating your part with 4th axis indexing 
or 5th axis positioning.  

• Multi axis positioning is not required to this part. Click No.   

• Stock and Setup are created according to the requirement. 

• Click Next and Finish as shown. 
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Stock creation and 
Setup creation are 
completed, as shown in 
the graphic window.          
Turn on the Toolbars 
required from the View 
menu, as shown. Click 
OK.  
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New Feature 
 

• Create New Feature. Select Side from 4-axis and Turn on Extract with Feature 
recognition 

 
• Click Next. 
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New Feature – Feature Extraction 

FeatureREGCONITION saves you time in creating a feature. It will extract the upper 
and lower curves from the surfaces for you. It will also create the necessary match 
points so that the toolpath is synchronized at the borders between surfaces. Without 
FeatureREGCONITION, you would have to extract the curves using the Surface 
Edges constructor and then tediously create the match points. 

• Select the first method and use Hide Horizontal Surfaces to hide Flat surfaces 
automatically. 

• Remaining has to select manually and hide using Right click of mouse.  
• Part will be displayed as shown below. Click Next. 
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New Feature Upper Surface Edges 

 Select Upper Surface edges using pick curve on surface icon     as shown. 
 While picking the edges, take a close look (Zoom) then select the edges. 
 Select those required from Upper Surface Edges and Click Next. 
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New Feature Lower Surface Edges 

• Select Lower Surface edges using pick curve on surface icon     as shown. 

• While picking the edges, take a close look (Zoom) then select the edges. 

• Select those required from Lower Surface Edges and click Preview. 

• There are some mismatching areas (highlighted). They are caused by the vertical 
drops in the upper curve and we will fix this problem in a later step. Note that 
FeatureREGCONITION can fix the vertical drops automatically if they are aligned 
with the Z-axis (the vertical drops here are slightly tilted). 

• Click Next. 
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New Feature - which side 
A large blue arrow is displayed pointing to the cutting side for each feature. You can 
modify the cutting side by selecting the curve in the table.  
• Clicking the reverse side  button.  
• Click Next when all the arrows are pointing in the out side direction.  

  

New Feature – Dimensions 

• Enter the thickness of stock and Click Next. 
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New feature - Start 
For 2 and 4-axis side features, the default is to start at the first point of the curve. To 
add new linear moves at the start or end of a curve. 

• If the feature has multiple curves, select the appropriate curve from the Curve drop 
down list.  

New feature - Match curve 

FeatureCAM attempts to match up the points of 
the upper and lower curves of a 4-axis feature. If 
the curves are not matched automatically, you 
can manually match the two curves (Upper and 
Lower).  

 

 

Keep View as Front. Take a close look into Mismatch area-1; 
you can see there are four points on Upper edge and two points 
on Lower edge. 
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Use following Steps to match the curves properly: 

Keep View as Front. 

Step1. Select Break into two at location. 

Step2. Select the Lower edge. 

Step3. Click at upper edge point, as 
shown. 

 

 

 

 

Step1. Select   . 

Step2. Select the Lower 
point. 

Step3. Select the Point 
exactly as shown in the 
Picture. 

 

 

 

 

 

Step4 & 5. To select the same lower point to another 
upper point, hold the Shift key and select the points 
exactly as shown in the picture.  
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Step6. Click Preview. Results will be OK as shown in below picture.  

 

 

 
 
 
 
 
 
 
 
 
 
Now take a look into Mismatch area-2. 
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Use following Steps to match the curves properly: 
 
Step1.  Select Break into two at location. 
Step2. Select the Lower edge. 

Step3. Click at upper edge point, as shown. Now the curve as broken into two pieces. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step1.  Select Break into two at location. 
Step2. Select the Lower edge as shown. 

Step3. Click at upper edge point exactly as shown. Now the curve as broken into three 
pieces. 

All these you need to do in a Closer view as the distance is very less between points. 
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Use Box Zoom and you can see there are two points showing in the lower edge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use Box Zoom for selecting each point. 

Step1. Select   . 

Step2. Select the Lower 
point. 

Step3. Select the Upper 
point as shown in the 
Picture. 

Click on preview. 
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Steps for matching the second point. 
 

Step1. Select   . 

Step2. Select the Lower 
point. 

Step3. Select the Upper 
point as shown in the 
Picture. 
Click on preview 
 
 
 
 
 
 
Final Matching Curve Results will be as shown: 
 
 
 

 

 

 

 

New Feature – Strategies  

 Primary cut direction 
• This attribute controls the 

direction of a cut. For closed 
curves the options are clockwise 
(CW) or counter-clockwise 
(CCW). For open curves the 
choices are right or left. These 
settings are relative to the 
machining side setting.  
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Offset method 
• This radio box controls whether the offsetting of the wire path is performed 

on the machine using cutter compensation or by FeatureCAM. Select 
Cutter comp to perform the offsetting on the machine, or Offset toolpath 
to have FeatureCAM perform the offsetting. Contour passes 

• The number of passes to take for the contour operation.  
  

• Click Next.  
 

 
 

 
 
New feature operations 
This page contains a summary of the 
operations that will be created to 
manufacture the feature, the names 
 of the tools that have been 
automatically selected, and the feed 
and speed values that were 
calculated automatically. Each 
 row of the table represents an 
operation.  

•  If you are familiar with the 
tooling names and satisfied with 
the selected tooling and feeds 
and speeds,  Click Finish.  

mk:@MSITStore:D:%5CProgram%20Files%5CDelcam%5CFeatureCAM_13.1%5CProgram%5CEZFM.chm::/EDMMachine/Contouring_cycle_compensation_on_machine.htm
mk:@MSITStore:D:%5CProgram%20Files%5CDelcam%5CFeatureCAM_13.1%5CProgram%5CEZFM.chm::/EDMMachine/contouring_compensation_Software.htm
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New Feature - Created 
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3D Simulation  
• Go to Simulation from the View menu and Click Start Simulation. 
• Play Simulation from the Simulation Menu to know the results. 
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NC Code 
Once you run the simulation Successfully, NC-Codes will be generated 
automatically. 
Click on the NC Code Tab as shown below. 
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Post Processor Selection 
• Open 

Manufacturing 
from the main 
menu and Select 
the Required Post 
processor as 
shown. 
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Save NC  

• Open NC Code window from Nc code Icon  and select Save the NC code 
on my computer’s disk drive.  

 
• Click OK. 

 

 
 





Demo: Quick 2-axis

• Open demo2x.fm. 
• Bring up the New Feature Wizard. 
• "We have die, punch and side features which corresponds 

to the types of parts people make with wire EDM." 
• Switch between die, punch and side. 
• Pick die, click Next, and then click Curve Chaining. 
• Chain the geometry by clicking on the bottom left 

horizontal line. 
• Click Next and Finish. 
• Rotate the part around. 
• Go to isometric view, run 3D sim, show that you can 

remove the core, and then rotate the part around. 
• Post NC code. 



Demo: Set Start Hole

• Go to the top view. 

• Bring up the Feature Properties 
dialog. 

• Go to the Start page. 

• Pick (5.75, 3.25) and then the 
bottom right horizontal line. 



Demo: Constant Taper

• Go to the Dimensions page. 
• Set taper to constant left. 
• Go to isometric view. 
• Set taper to constant right. 
• "We also support ISO or cylindrical taper vs. the 

regular or conical taper." 
• Go to top view. 
• Set taper to constant ISO right. 
• Zoom in to the bottom arc to show that the taper 

is cylindrical (same radius). 
• Switch back to constant right to show the 

difference. 



Demo: Variable Taper

• Zoom out to show the part again. 
• Set taper to variable. 
• In the Variable Taper dialog, set everything to (right, 10, 

10). 
• "Let me first set everything to have the same setting as 

constant taper right 10 degrees. As you can see the shape 
didn't change." 

• Uncheck Auto Fill Down. 
• Pick the arcs and change them to ISO. 
• "You can also vary the taper angle." 
• Change Angle to 20 on the next line. 
• "If you don't want a in-place taper angle change." 
• Change First Angle to 20 on the arc after the line. 



Demo Round/ISO

• Open RoundedISO.fm

• Create a new Die feature

• Make a constant 10 degree right 
taper

• Try the different rounded and taper 
strategies



Demo: Skim Cuts
• Set taper to none. 
• Go to the Strategy page. 
• Point at Contour Passes. 
• "The number of passes is currently set to 1 so you will see only 1 pass in the 

simulation." 
• Isometric view. 
• Lower sim speed. 
• 3D sim. 
• Change Contour Passes to 3. 
• 3D sim. 
• "Right now we are using cutter comp as the offset method so the toolpath for the 3 

passes are not offset. The NC code will have different cutter comps for each pass for 
the wire EDM machine to do the offsetting. I will talk more about this later. Another 
way of making skim cuts is to actually generate offset toolpath..." 

• Change to Offset Toolpath. 
• Top view. 
• Centerline sim. 
• Zoom to show offset toolpath. 
• Center all. 



Demo: Power Settings
• Change back to Cutter Comp. 
• Click on the operation to show the Cutting Data page. 
• "As you can see the feed, water and comp reg are different for each pass. The comp 

reg is for the offsetting that we just talked about. These numbers are actually 
register numbers that refer to specific settings on the wire EDM machine. For 
example, the 415 feed register number refers to a specific electrical power setting on 
the machine." 

• Show the feeds and comp regs in the NC code. 
• "If you want different numbers, you can change them in..." 
• Show changing a number in the Cutting Data page. 
• "The defaults comes from a table in the Cutting Data Tables dialog. To find the table, 

we use your stock material, wire and machine combination. You can see your 
combination on..." 

• Open stock dialog. 
• Point to the material, wire and machine area. 
• "You can change your combination by..." 
• Click Condition. 
• "Here is the Cutting Data Tables dialog. Here is a table for 2 passes, 3 passes, and a 

table for Carbide." 
• Click Cutting Data. 
• Change passes to 2 and 3. 
• Change material to carbide. 



Demo: Retract and Cutoff Ops

• Set operations to Retract+Cutoff. 
• Isometric view. 
• "Let me run the simulation to the end of the Retract operation." 
• 3D sim to Next Operation. 
• "This operation could be run overnight. When it is done, the machine would stop. The 

uncut region keeps the core in place. If the core were cut loose, it would have fell 
and interfered with the wire movement. Also, the retract move makes sure the burn 
mark from the wire changing cut direction is away from the part. So in the morning, 
the operator would put magnets or glues to hold the core in place, and then he would 
continue the cutting with the Cutoff operation." 

• 3D sim and remove core. 
• "Pocketing and zigzag are two other useful operations. They are no-core operations 

meaning that the entire core is burned away." 
• Top view. 
• Create a die with a small circle. 
• Set operations to pocketing. 
• Centerline sim. 
• Change operations to zigzag. 
• Centerline sim. 



Demo: 4-axis Wire

• Open 4x1.fm. 
• Bring up the New Feature Wizard. 
• "Again, we have die, punch and side features just like in 2-axis." 
• Pick die. 
• Use the inner geometry for the upper curve and the outer for the 

lower. 
• Set thickness to 2. 
• "The feature is all twisted right now because we have not set the 

start points." 
• Set start points to the middle. 
• Finish. 
• Rotate the part around. 
• "Since there are the same number of geometry pieces on the 

upper and lower curves, the part's shape came out nicely. “



Curve Matching

• FeatureCAM 
attempts to match 
up the points of 
the upper and 
lower curves of a 
4-axis feature. 

• If the curves are 
not matched as 
you would like, 
then you can 
manually match 
the two curves. 



Demo: 4-axis Matching

• Open 4x2.fm. 
• Bring up the New Feature Wizard. 
• Pick die. 
• Use the inner geometry for the upper curve and the outer for the 

lower. 
• Set thickness to 2. 
• Set start points to the middle. 
• "Since there are different number of geometry pieces on the 

upper and lower curves, FeatureWIRE does a length-based 
synchronization of the two curves, which is not what I want for 
this part. To control the synchronization, I will go to the next 
page..." 

• Next. 
• Match the two lower left points to the upper left point. 
• Finish. 
• Rotate the part around. 



Advanced Demos

• 3D curves in 4-axis

• Posting for older Agie machines

• Posting for newer Agie machines

• UDF



Demo: 3D Curve in 4-axis

• This is useful when you get a model from someone and the 
surfaces that you want to cut do not give you planar curves.

• Open 3d.fm. 
• Shade the surface and rotate it around.
• Unshade the surface
• Bring up the New Feature Wizard. 
• Make a 4-axis side with curve1 as upper and curve2 as lower.
• Set the thickness to the distance between the curves.
• Finish. 
• Shade the surface.
• Rotate the part around to show that it matches with the surface. 



Demo: Posting for Older Agie 
Machines

• For older Agie machines that take NC code with full toolpath.
• Those machines have special requirements for cutter comp.
• Open agie.fm. 
• Rotate it around.
• Change post to “sodickdi.cnc”. Not using Agie posts since the the XY 

coordinates in those posts are incremental.
• Generate NC code.
• Show that the XY match with the part.
• Open the Post Options dialog.
• Set Agie Control to Yes and click OK to repost.
• The first two moves are swapped.
• G40 in the second move.
• A dummy perpendicular move is added before the last move.
• Change Agie Control back to No.



Demo: Posting for Newer Agie 
Machines

• For newer Agie machines that take ISO, SBR, SBL files.
• ISO file for the shape of the part.
• SBR and SBL files for the script that controls the cutting.
• Open agie2.fm.
• The operation has to be ‘Contour’ with 1 pass.
• Change the post to “agie-die.cnc”.
• Open the Add-ins dialog and add PostToAgie.bas.
• Open the Run Basic Macro dialog and run PostToAgie.
• Show that the XY match with the part.
• A dialog pops up showing what files are generated.
• You can customize the agie-die.cnc.



Demo: UDF

• UDF stands for User Defined Feature.
• The idea is to be able to insert custom NC code.
• Open a new wire part.
• Change the post to “sodickdi.cnc”.
• Open the post in Xbuild.
• The UDF Text format has to be filled in.
• Open the Add-ins dialog and add “Code-Comment operation.bas”.
• Bring up the New Feature Wizard.
• Create the UDF.
• Add some code and comment.
• Generate NC code.
• If you have other features, you can move the UDF around.
• You can create your own UDF (e.g. probe.bas)
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